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About this Manual
This manual describes the structure, project engineering and the handling
of the Operator Panel OP 03 from VIPA.

Outline

Chapter 1:
Hardware description
This chapter describes the structure of the jacks and plugs and the
assembly. The chapter closes with the technical data.
Chapter 2:
Deployment OP 03
This chapter contains information about the project engineering and the
operation of the OP 03. The chapter starts with the assembly, followed by a
description of the general operation of the OP 03 and the SETUP.
The chapter closes with a short description of OP-manager, the project
engineering tool from VIPA and with information about firmware updates.
Chapter 3:
Functions OP 03
Theme of this chapter are the integrated functionalities of the operator
panel OP 03. It contains the description of the general operation, screens,
system settings, StatVAR, SteuVAR and password input.
Chapter 4:
General installation guidelines
This chapter helps you to install an interference-free automation system.
First, possible interference sources and their interaction mechanisms are
shown, followed by basic rules for guaranteeing EMC. Afterwards you'll find
information about assembly and cabling following EMC rules.

Subject to change to cater for technical progress.
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User considerations

User considerations
Objective and
contents

This manual describes the Operator Panel OP 03 from VIPA. It describes
the installation, project engineering, usage and the technical data.

Target audience

The manual is targeted at users who have a background in automation
technology and PLC programming.

Structure of the
manual

This manual consists of chapters. Every chapter provides the description of
one specific topic.

Guide to the
document

This manual provides the following guides:
• An overall table of contents at the beginning of the manual
• An overview of the topics for every chapter
• An index at the end of the manual.

Availability

The manual is available in:
• printed form, on paper
• in electronic form as PDF-file (Adobe Acrobat Reader)

Icons
Headings

Important passages in the text are highlighted by following icons and
headings:

Danger!
Immediate or likely danger.
Personal injury is possible.

Attention!
Damages to property is likely if these warnings are not heeded.

Note!
Supplementary information and useful tips.

HB116E - OP03 - Rev. 07/50
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Safety information
Application
specifications

The Operation devices are constructed and manufactured for:
• VIPA CPUs 11x, 21x, 31x, 51x and S7-300/400 from Siemens
• communication and process control
• industrial applications
• operation within the environmental conditions specified in the technical
data

Danger!
This device is not certified for applications in
• explosive environments (EX-zone)

Documentation

The manual must be available to all personnel in the
• project design department
• installation department
• commissioning
• operation

The following conditions must be met before using or commissioning
the components described in this manual:
• Modification to the process control system should only be carried out
when the system has been disconnected from power!
• Installation and modifications only by properly trained personnel
• The national rules and regulations of the respective country must be
satisfied (installation, safety, EMC ...)

Disposal

2

National rules and regulations apply to the disposal of the unit!
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Chapter 1

Hardware description

Overview

In this chapter the hardware components of the OP 03 are described.
Besides of a description of the single components, the dimensions that are
required for the installation may also be found. The chapter closes with the
technical data.
Please consider the safety hints at the beginning of the chapter.

The following text describes:
• Safety hints
• Control elements and connectors
• Dimensions for installation and technical data

Content

Topic
Page
Chapter 1
Hardware description ..................................................... 1-1
Safety information for Users................................................................. 1-2
Properties............................................................................................. 1-4
Structure .............................................................................................. 1-5
Dimensions .......................................................................................... 1-7
Technical data...................................................................................... 1-8
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Safety information for Users
Handling of
electrostatic
sensitive modules

VIPA modules make use of highly integrated components in MOStechnology. These components are extremely sensitive to over-voltages
that can occur during electrostatic discharges.
The following symbol is attached to modules that can be destroyed by
electrostatic discharges:

The symbol is located on the module, the module rack or on packing
material and it indicates the presence of electrostatic sensitive equipment.
It is possible that electrostatic sensitive equipment is destroyed by energies
and voltages that are far less than the human threshold of perception.
These voltages can occur where persons do not discharge themselves
before handling electrostatic sensitive modules and they can damage
components thereby, causing the module to become inoperable or
unusable.
Modules that have been damaged by electrostatic discharges may fail after
a temperature change, mechanical shock or changes in the electrical load.
Only the consequent implementation of protection devices and meticulous
attention to the applicable rules and regulations for handling the respective
equipment can prevent failures of electrostatic sensitive modules.

Attention!
• If your panel is to be supplied externally, you have to make sure that the
communication cable does not have any power allocation. Otherwise the
connected devices could be damaged.
• Before commissioning, the device has to be brought in environment
temperature.
• With condensation you may only switch on the device after complete
dryness.
• To prevent overheat during operation avoid direct sun contact of the
device.
• After opening of the control cabinet or panel, parts of the system are
available that may lead dangerous voltage.
• All signal connections require screened cables.
• Signal cores may not be lead within a cable shaft of high-voltage cores.
• Please take care for sufficient ground of the operating device. For this a
ground screw is to be found at the backside of the device.

1-2
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Shipping of
electrostatic
sensitive modules

Modules have to be shipped in the original packing material.

Measurements
and alterations on
electrostatic
sensitive modules

When you are conducting measurements on electrostatic sensitive
modules you should take the following precautions:
• Floating instruments must be discharged before use.
• Instruments must be grounded.
Modifying electrostatic sensitive modules you should only use soldering
irons with grounded tips.
Attention!
Personnel and instruments should be grounded when working on
electrostatic sensitive modules.

HB116E - OP03 - Rev. 07/50
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Properties
General

The here shown operating device allows you to visualize and alter
operating states and recent process values of a connected PLC. For the
entry of values and navigation, the operating device is provided with an
integrated keyboard and a 2x20 character display. The link-up to your PLC
happens via MPI.
The project engineering takes place in the project engineering tool "OPManager" from VIPA that enables the online project engineering via MPI.
The OP 03 allows you the access to up to 2 CPUs.

Properties

VIPA 603-1OP00
• Die-cast aluminum case
• Protection type: front side IP65, back side IP20
• Display with 2 x 20 characters
• 256kB user memory, 4096 variables
• MP2I interface for online project engineering, CPU link-up and firmware update
• Project engineering via VIPA OP-Manager or ProTool from Siemens
• Visualization of max. two CPUs via MPI
• Menus and input requests in 8 languages
• Read and alter time and counter value
• Monitoring of messages
• Easy installation via non-looseable rocker arms
VIPA 603-1OP10
as like as VIPA 603-1OP00 with differences as follows:
• Project engineering only with OP-Manager from VIPA
• Menus and input requests in 2 languages (English, Russian)

1-4
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Structure
At the front side of the Operator Panel OP 03 are the foil keyboard and the
display with 2x20 characters.

Front view

Operator Panel
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Navigation keys
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At the OP 03 the connectors are located at the backside.

Back view
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[3]
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MP I interface
Ground screw
Additional slot for DC 24V
power supply

G
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M

M

DC24V

X 2
3 4

VIPA 603-1OP00

Attention!
The simultaneous usage of external power supply and the delivered MPI
cable 670-0KB00 is not allowed and damages the OP 03 and the CPU!
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Components

LC-Display

The OP 03 monitors values and messages via a STN text display with LED
back lighting. It displays 2 rows with max. 20 characters with a line height
of 5mm.

Keyboard

At the front side is a foil keyboard with 18 short click keys. 8 keys are
serving the navigation and 10 keys are for numeric input.
The numeric keys F1 ... F5 are configurable as soft key with display
depending functions via the VIPA project engineering tool.

MP2I

2
The OP 03 is provided with a MP I (Multi-Point-Interface) for connection to
your CPU via a MPI network and for serial connection to a PC using the
Green Cable from VIPA
The MP2I jack has the following pin assignment:

9pin jack
Pin
1
2
3
4
5
6
7
8
9

5
9
4
8
3
7
2
6
1

Additional
Power supply
+

L+

M

M

Assignment
reserved (must not be connected)
M24V
RxD/TxD-P (Line B)
RTS
M5V
P5V
P24V
RxD/TxD-N (Line A)
n.c.

If you use a MPI cable without power allocation instead of the delivered
MPI cable 670-0KB00, the OP 03 may externally be supplied with DC 24V
(20.4 ... 28.8V) using this addition power supply slot. The power supply is
protected against inverse polarity and over-current.
The simultaneous usage of external power supply and the delivered
MPI cable 670-0KB00 is not allowed and damages the OP 03!

DC24V

1-6
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Dimensions
Installation
dimensions

For the installation of the OP 03, an installation cutting with the dimensions
156mm x 78mm is required.
Installation values for control cabinets and desks:
Front panel width:
Installation cutting (W x H):
Installation depth plus cabling

max. 6mm
156mm x 78mm
34mm

28

34

40

Top view

90

77

Back view
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P
I

G

DC24V

X1
L+

+

M

-

X 2
3 4

VIPA 603-1OP00

154
187
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Technical data
OP 03 - Operator Panel
Electrical data
Nominal supply voltage
Current consumption
Max. inrush current
ESD/Burst
Shock resistance
Level of noise suppression
Memory
Project memory
Number of variables
Operation panel
Display
- Number of rows
- Characters per row
- Character height (mm)
Keyboard
- Number of system keys
- Numeric keys and Soft keys
Interface
2
MP I
Environment conditions
Case
- Protect type front side
- Protect type back side
Operating temperature
Storage temperature
Relative humidity
- Operation
- Storage/Transport
Dimensions and weight
Front side (WxH)
Back side (WxHxD)
Installation cutting (WxH)
Weight

VIPA 603-1OP00, VIPA 603-1OP10
DC 24V (20.4 ... 28.8V)
max. 80mA
3A, 10µs (at 30V)
Acc. IEC 61000-4-2 / IEC 61000-4-4 (up to level 3)
Acc. IEC 60068-2-6 / IEC 60068-2-27 (1G/12G)
Acc. IEC 61000-6-4
256kByte (Flash-ROM)
4096
STN display with LED back lighting
2
20
5
Foil keyboard with 18 keys
8
10
9pin D-Type jack at the back side for up to 3 MPI
connections res. serial via Green Cable
Die-cast aluminum case
IP65
IP20
0 ... +60°C
-20 ... +70°C
5% to 85% at 30°C
5% to 93% at 40°C (without condensation)
187x90mm
154x77x40mm
156x78mm
730g

Supported
languages
VIPA 603-1OP00
VIPA 603-1OP10

1-8

German, English, French, Spanish, Italian, Swedish,
Norwegian, Danish
English, Russian
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Chapter 2

Deployment OP 03

Overview

This chapter explains the deployment and the project engineering of the
OP 03.
After the fast introduction there are information about the installation of the
OP 03 and the configuration by the OP-Manager. This is followed by the
description of commissioning and operation of the OP 03. The chapter
closes with a description of the firmware update.

The following text describes:
• Fast introduction
• Installation
• Configuration
• Commissioning
• Operation and firmware update

Content

Topic
Page
Chapter 2
Deployment OP 03 .......................................................... 2-1
Fast introduction................................................................................... 2-2
Installation ............................................................................................ 2-6
Project engineering - Overview ............................................................ 2-7
Project engineering - Deployment OP-Manager ................................... 2-8
Commissioning................................................................................... 2-16
Operating the OP 03 .......................................................................... 2-20
Firmware update of the OP 03 ........................................................... 2-22
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Fast introduction

Installation

Build the CPU system and install the OP 03. For the installation in
operating tables and control cabinet fronts a front panel cutting of
156mmx78mm (LxW) is needed.

Configuration

The project engineering takes place in the configuration tool "OP-Manager"
from VIPA that enables the online project engineering via MPI. The OP 03
allows you to access up to 2 CPUs.

Deployment
OP-Manager
.
Start the OP-Manager via click on
Open the dialog window for a new project via File > New. Enter a name
and the according operating device and click on

. For the first

.
start, you should work with the standard project. Click on
The project window opens with the standard project that is already stored
in the OP.
Now you may change the values of the object groups "Screens",
"Messages", "Tags" etc. by clicking on the according group and preset their
objects in the object window.
Create, alter and
delete an object

Within an object group you may create a new object via

, alter it via

and delete it with
. These functions are equal to the context
functions Insert, Open res. Properties and Delete.
Controllers
Insert a CPU (control) with
parameter.
Create tag

and set the according MPI communications

With Tags you define all variables that refer to memory areas of the PLC
and that have to be processed in the OP.
. Enter a name for the variable and a
To create a new variable, click on
corresponding memory area of your PLC. The OP 03 can control up to 2
CPUs (Controllers).

2-2
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The display of a message happens event triggered. As soon as an event
occurs in the specified CPU, the according message is monitored sorted
. The definition of the
after priority that can be acknowledged with
events happens under "Area Pointer" on project level. Here you assign a
memory res. bit memory area of your PLC. The object groups "Messages"
allow you to enter the according messages.

Create screen
.
Click on the object group "Screens" and create a new screen with
Screens consist of entries. Every screen can contain up to 20 entries.
Always one entry is monitored per display page in a 2x20 character mask
where you can branch if needed. You may enter the following elements in
an entry:
• Alpha numeric texts (no umlaut)
as:
• Variables for in- res. output via
- Tag: Variable that is linked to a value in the PLC with settable in- res.
output format. You may also output plain text from a list that
concerns to a PLC value. The list for the text assignment is
stored in the object group "Text/Graphics Lists".
- Date, Time: internal date and time-of-day
that allows to execute programmed functions
• Soft key
like e.g. a jump in a special entry.
Compile and
emulate

After you have finished the presetting, you save your project with

,

and start it with an emulator with
. The emulator
compile it with
creates an OP 03 on your PC and gives you the opportunity to test your
programming without additional hardware.
brings you to the screen defined as start screen. The lower part of
the emulator allows you to simulate events via PLC 1 res. PLC 2 that are
later coming from the real CPU. Please take care that the according events
are programmed in your project engineering under "Area Pointers".
You may also use the menu option "Switch to Green Cable Mode" to
directly connect your PC with the CPU via Green Cable and test your
programming on the emulator.

Note!
The online project engineering requires a licensed version of the OPManager! More information may be found at the online help of the OPManager.

HB116E - OP03 - Rev. 07/50
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Commissioning

For commissioning the OP 03 is to be connected to the PC. Since here the
OP 03 is to be served by DC 24V there are the following possibilities:
• Transfer by Green Cable
• Transfer by MPI converter

Transfer via
Green Cable

Here the transfer is executed via an exclusively directly connected Green
Cable from VIPA and external power supply.
The external power supply must be disconnected before operating with the
CPU by means of the delivered MPI cable (VIPA 670-0KB00).

DC 24V

OP 03

OP-Manager

Operator Panel

CPU
CPU

OP03
ESC

,

+/F1

F2

F3

F4

MP2I

F5

1

2

3

4

5

6

7

8

9

0

SHIFT

ENTER

MPI

VIPA 670-0KB00

RS232
Green Cable (VIPA 950-0KB00)
Attention!
• Simultaneous voltage supply by MPI and external connection is not
allowed and damages the hardware!
• The Green Cable may exclusively deployed directly at the concerning
jacks of the VIPA components (in between plugs are not permitted).
• The lengthening of the Green Cable with another Green Cable res. The
combination with further MPI cables is not permitted and causes
damages of the connected components! The Green Cable may only be
lengthened with a 1:1 cable (all 9 Pins are connected 1:1).

Transfer by
MPI adapter

With this transfer method the OP 03 is powered by the power supply of the
CPU when connecting this by the delivered MPI cable (VIPA 670-0KB00) to
the CPU. For project engineering a MPI converter from VIPA may be
attached to this cable.

OP 03

OP-Manager

CPU

Operator Panel

OP03
ESC

CPU

,

+/F1

F2

1

F3

2

MP I
6

2

7

F4

F5

3

4

5

8

9

0

MPI

MP2I
SHIFT

ENTER

VIPA 670-0KB00

MPI converter
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If the standard project is in the OP 03, you may set the OP mode "Operat.
mode Transfer" via System > OP-Mode, entering the password 100 and
.
confirm with
Now the OP 03 awaits data with "Ready for Transfer".
If the standard project is not yet present the setup menu may be connected
with the following proceeding:
Push the key combination
+
+
on the OP 03 and turn it on
again. Hold the keys until the OP 03 branches to the "Setup menu".
Choose with
"Perform Download from PC" and push
The OP 03 now awaits data with "Ready for Transfer".
This operation may always be aborted by

Start transfer at
OP-Manager

.

.

Load the OP-Manager with your project on your PC. You may only access
the OP 03 online, if you work with a licensed version.
Call the transfer function with a click on
.
Select MPI and set the transfer parameters like COM port, baud rate 38400
via

and confirm your entry.

configuration is confirmed and the transfer is started. After
With
the transfer, the OP 03 starts with the new project.
Operation

Connect after transmission the MPI jack of CPU and OP 03 by means of
the delivered MPI cable. As soon as the power supply of the CPU is
switched on, the OP 03 is power supplied via MPI and starts automatically
with the project.

Operation
OP-Manager

CPU

OP 03
Operator Panel

CPU

OP03
ESC

,

+/F1

F2

F3

F4

2

3

4

5

6

7

8

9

0

SHIFT

ENTER

MPI

VIPA 670-0KB00

not permitted
OP-Manager

MP2I

F5

1

DC 24V

OP 03
Operator Panel

CPU
CPU

OP03
ESC

,

+/F1

F2

F3

2

3

4

5

6

7

8

9

0

MPI

MP2I

F5

F4

1

SHIFT

ENTER

VIPA 670-0KB00

RS232
Green Cable (VIPA 950-0KB00)

These steps of the fast introduction are more described at the following
pages.
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Installation
Overview

The OP 03 is suitable for the installation in operating tables and control
cabinet fronts. The installation happens via the back side. The OP 03 is
provided with a patented integrated fixing technique that allows an easy
connection with a simple screwdriver.

Note!
Please also regard the "General installation guidelines" in this manual.

Installation cutting

For the installation in operating tables and control cabinet fronts, you need
the following front panel cutting:

78mm

156mm

Installation

The fixing technique is integrated in the casing of the OP 03 and
accessible via the back side.
For the installation, a small slit screwdriver is required. Push the operator
panel [3] from the front side into the front panel cutting [1] until it touches
the panel with the seal [2]. Now bolt the lever [5] clockwise with the
screwdriver [4] until it rotates to the outside. Further screwing bolts the
lever to the front panel until it holds the OP 03 to the control cabinet front.
4

5
1
2

2-6
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Project engineering - Overview
The OP 03 allows you the access to up to 2 CPUs. From the software side
the link happens by means of a project stored in the OP 03. For the project
engineering of the OP 03 operating surface you may use the OP-Manager
from VIPA or ProTool from Siemens. Your project is transferred via MPI
from the PC into the OP 03.
During operation the OP 03 communicates with the concerning CPU
control and responds to the application processing of the PLC according to
the engineered presetting. With concerning project engineering, you may
monitor respectively alter process values via the display and transfer them
to the CPU.

Overview

Project engineering
Variant 1

DC 24V

OP 03

OP-Manager

Operator Panel

CPU
CPU

OP03
ESC

,

+/F1

F2

F3

F4

MP2I

F5

1

2

3

4

5

6

7

8

9

0

SHIFT

ENTER

MPI

VIPA 670-0KB00

RS232
Green Cable (VIPA 950-0KB00)

Variant 2
OP 03

OP-Manager

CPU

Operator Panel

OP03
ESC

CPU

,

+/F1

F2

1

F3

MP2I
6

F5

F4

3

4

5

8

9

0

2

7

MP2I
SHIFT

ENTER

MPI

VIPA 670-0KB00

MPI converter

Operation
OP-Manager

CPU

OP 03
Operator Panel

CPU

OP03
ESC

,

+/F1

F2

F3

1

2

6

7

F4

3

8

MP2I

F5

4

5

9

0

SHIFT

ENTER

MPI

VIPA 670-0KB00

not permitted
OP-Manager

DC 24V

OP 03
Operator Panel

CPU
CPU

OP03
ESC

,

+/F1

F2

F3

F4

2

3

4

5

6

7

8

9

0

MPI

MP2I

F5

1

SHIFT

ENTER

VIPA 670-0KB00

RS232
Green Cable (VIPA 950-0KB00)

Attention!
Please note the VIPA Green Cable and the delivered MPI cable 670-0KB00
may not be used simultaneously at the MP2I interface of the OP 03.
Otherwise CPU and OP 03 are damaged!
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Project engineering - Deployment OP-Manager
Overview

For the project engineering of the OP 03 operating surface you may use
the OP-Manager from VIPA or ProTool from Siemens.
Please note the OP 03 with order number VIPA 603-1OP10 may
exclusively be configured by the VIPA OP-Manager.
For both tools are similar in structure and operation, the project
engineering is illustrated in the OP-Manager from VIPA.
The OP-Manager runs with Windows 2000 and XP. The OP-Manager
offers you a fully graphical user interface that allows you a comfortable
project engineering in 3 different languages.
You transfer your project engineering into your OP 03 via MPI.

Differences to
ProTool

In opposite to ProTool, the OP-Manager has an integrated emulator that
simulates an operation panel on your PC. You can test your project
engineering without additional hardware. You may also use the COM
interface to connect a CPU via MPI that can be accessed by the emulator.
The area pointers are to find in the OP-Manager in the register "Area
Pointer".

The languages that are available in your project are set in the register
"Language Assignment".

Glossary

The following table lists the terms that are used for the project engineering
in the OP-Manager.
Meaning
Pictures
Messages
Variables

2-8

Term
Screens
Messages
Tags

Meaning
PLC
Symbolic lists
Area Pointer

Term
Controllers
Text/Graphic Lists
Area Pointer
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Create project
Start the OP-Manager by clicking on
.
Open the dialog window for a new project via File > New. Enter a name
and the according operating device and click on

. For the first

.
start, you should work with the standard project. Click on
The project window opens with the standard project that is already stored
in the OP.
You may alter the name for your project or add a description via File >
Project Information at any time.

1
2

3

4

5

6

7
The project window contains the following important elements:
[1] Symbol bar with the most important functions. Here you also set the
language that is to be altered.
[2] This area shows your project with the concerning object groups in a
tree structure.
[3] Here you see the objects of an object group.
[4] As soon as you choose your project as object group, among others,
the register "Area Pointer" is available. Under "Area Pointer" you may
assign certain events in your CPU to a state in your OP like e.g. open
a screen or throw one of the messages that you can define under
"Messages".
[5] As soon as you choose your project as object group, among others,
the register "Language Assignment" is available. Depending on the
used OP 03 up to 3 languages may be fixed here, which are available
in your project.
[6] Here are the status messages that are creates at a compiler run res.
Download.
[7] OP-Manager information window. Information about the entry mode
(OVR=Overwrite), the chosen language and the type of the operating
panel.

HB116E - OP03 - Rev. 07/50
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Insert objects

Within an object group you may create a new project via

in the symbol

bar, alter it with
and delete it with
. These functions are equal to
the context functions Insert, Open res. Properties and Delete.

Object overview

The following objects are available:
• Controllers (CPU and MPI communication parameter)
• Tags (Variables referring to PLC areas)
• Messages (messages that can be thrown event triggered)
• Screens (output areas on the operator panel)
• Text/Graphic Lists (Plain text assignment for tags)

Controllers (CPUs)

When you create a new project, a controller is automatically created too.
With a double click on this controller, you reach the "PLC" dialog window.

2
1

3

Here you can enter a label for your CPU, set the polling rate and set res.
alter the following parameters via

:

OP Parameters:
Address: 1 (MPI address of the operating device)
Network Parameters: Baud rate: 187.5 (MPI baud rate)
Peer Parameters:
Address: 2 (MPI address of the CPU)
Expansion Slot: 0 (Number expansion slot)
Rack: 0 (Number of the rack)
The OP 03 allows you access to up to 2 CPUs.
To include a 2. CPU, click on
communication parameter.

2-10
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Under "Tags" you define all variables that refer to memory areas of your
PLC and have to be processed by the OP.
to create a new variable. Enter a name for the new tag and a
Click on
corresponding memory area of your PLC. The OP 03 controls up to 2
CPUs (Controllers).

Via the register "Limit Value" you may define areas for input variables.
When you enter a value exceeding this range, the input is rejected.
Some variable types can be configured via the register "Functions".
"Options" allows you to enter a comment to the variables.

Messages

The output of a message happens event triggered. As soon as an event
occurs in the specified CPU, the according messages are shown sorted by
priority.
Please regard that you first have to define the initializing event in the
project object group, register "Area Pointer", if you want a message
because of a CPU event.
For this, create a new object with the type "Event Messages" via the
register "Area Pointer" with
and assign a DB or bit memory area. For
the output follows the bit pattern of the defined area, several messages can
be displayed simultaneously. The output is sorted after priority starting with
priority 1.
Every message must be acknowledged with

HB116E - OP03 - Rev. 07/50
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Screens

"Screens" allows you to monitor an image of the process. You may display
processes and preset process values.
The screen object contains several screen entries. One screen entry has
display size (2x20 characters) and is marked with an entry number. With
the object name and the entry number you may directly access a screen
entry.
You may place the following elements into a screen object:
• Alpha numeric texts
• Variables for in- res. output via
as:
- Tag: Variable that is linked to a value in the PLC with settable in- res.
output format. You may also output plain text from a list that
concerns to a PLC value. The list for the text assignment is
stored in the object group "Text/Graphics Lists".
- Date: internal date
- Time: internal time-of-day
The format of date respectively time of day and the flashing of the input

fields may be set by

.

• Soft key
that allows to execute programmed functions
like e.g. a jump in a special entry.

. Click
Click on the object group Screens and create a new screen with
on the 1. screen entry and insert the wanted elements. This screen is
automatically the start screen. You can assign the "start screen" property
to another screen via the object properties.
You may also alter the language during the project engineering. This only
influences the monitored text.

2-12
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Every screen entry has a soft key bar in the lower part of the window. Here
you can assign a function to one of the function keys (1...5). Click on the
according function key and assign a function via
like e.g. jump
into screen entry.
The access to the soft keys may be configured with or without additional
key. This may be set with

Password
protection for
soft keys

Set SupervisorPassword

.

To prevent unauthorized operating, the OP 03 has an integrated password
protection that enables passwords for up to 8 levels. Access to all
password levels (Level 9) is only allowed with the "Supervisor-Password"
that is defined in your project.
The assignment of the according password level happens in the OPManager. Here you can assign password levels from 1 to 9 according to
the raising importance of the functions assigned to the soft keys. Setting
Level 0 deactivates the password request.
You may set the passwords for the levels 1 to 8 only at the OP 03. You
need access to the screen "Password" in your project (see standard
project).
For access to this screen, the "Supervisor-Password" is required.
The Supervisor-Password allows full access to all functions of the OP 03.
The Supervisor-Password is transferred to the OP 03 together with the
project. To enter the Supervisor-Password, choose
The following dialog window appears:

in your project.

Under "Supervisor" you type a password
and set via "Logout Time" the time for
which the password is valid after login.

Set password
level

You may set a password level for every soft key definition like shown in the
picture.
Please regard that the password levels
for integrated standard screens of the
OP 03 are preset e.g.:
Level 9: Password Edit, OP-Mode
Level 8: ForceVAR
Level 6: System>MPI-Adr
Level 4: System>Dat/Time
Level 2: System>Language
Level 0: StatVAR, Password>Logout

HB116E - OP03 - Rev. 07/50
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Text/Graphics Lists

This object allows you to assign a text to a numeric value, which you can
refer to via a tag (variable).
Mark the object group "Text/Graphics Lists" and add a new object with
assigns a text to a numeric value.

The reference to a tag is set in the screen object. Insert a field within a
screen entry with
, select the property "Text" at "Display As", choose
the according tag and your list object at "Text List".

Note!
Please regard that the output is restricted to texts that are assigned to a
numeric value. Values without text assignment are displayed as "∗∗∗∗∗".

Integrated screens

In delivery state, the OP has integrated standard screens that are
described in the following:
Screen name
Change modes
Language
Edit password
Time/Date
MPI address

2-14

Usage
Switch between Online-, Offline- and Transfer operation
Language selection
Here you may set the passwords for the different levels
(Default: 100) and login via a password.
Date and time input
Input of MPI address and baud rate
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Emulate project

The OP-Manager provides you with an OP emulator that emulates an
OP 03 on your Windows system. This allows you to test your project
engineering without further hardware needs.
To start the emulator, you first have to compile your project with

and

save it. After the compilation you may start the emulator with
. After
every change of the program, you have to recompile it again. The emulator
has the following structure:

The upper half shows an original OP 03 with line display and keyboard.
The lower half allows you to simulate an event on a specified CPU. Here
you may jump to special screen entries by presetting the according values
res. cause messages.
You may also use the menu option "Switch to Green Cable Mode" to
directly connect your PC with the CPU via Green Cable and test your
programming on the emulator.
When your programming runs error-free on the emulator, you may transfer
your project via MPI into your OP 03.

Note!
Please regard that the CPU emulation only works when you've created
objects of the type "Screen Number" and "Event Messages" in your project
group in the register "Area Pointer".

HB116E - OP03 - Rev. 07/50

2-15

Manual VIPA HMI

Chapter 2 Deployment OP 03

Commissioning

Preconditions

• CPU system is built.
• A project has been configured by the OP-Manager and is ready for
download.

Project transfer

The online project engineering requires a licensed version of the OPManager! More information may be found at the online help of the OPManager.
For project transfer the OP 03 is to be connected with the PC. Since here
the OP 03 is to be served by DC 24V there are the following possibilities:
• Transfer by Green Cable
• Transfer by MPI converter
In the following the commissioning is described concerning these variants.

Transfer by
Green Cable

Here the transfer is executed via an exclusively directly connected Green
Cable from VIPA and external power supply.
The external power supply must be disconnected before operating with the
CPU by means of the delivered MPI cable (VIPA 670-0KB00).

Green Cable
connection

Connect the RS232 interface of your PC and the MPI interface of the
OP 03 by VIPA Green Cable. Please regard the following hints:
Attention!
• Simultaneous voltage supply by MPI and external connection is not
allowed and damages the hardware!
• The Green Cable may exclusively deployed directly at the concerning
MP2I jacks of the VIPA components (in between plugs are not
permitted).
• The lengthening of the Green Cable with another Green Cable res. The
combination with further MPI cables is not permitted and causes
damages of the connected components! The Green Cable may only be
lengthened with a 1:1 cable (all 9 Pins are connected 1:1).

OP-Manager

DC 24V

OP 03
Operator Panel

CPU
CPU

OP03
ESC

,

+/F1

F2

F3

1

2

6

7

F4

3

8

MPI

MP2I

F5

4

5

9

0

SHIFT

ENTER

VIPA 670-0KB00

RS232
Green Cable (VIPA 950-0KB00)
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Connecting external
power supply
1

3

For external DC 24V power supply there is a connector at the back side of
the OP 03 covered by a sticker with safety hints. Before connecting an
external power supply first the sticker is to be removed.
The wiring takes place with spring clamp technology. The cabling with
spring clamp technique enables a fast and easy connection of your supply
wires. In opposite to a screw connection, this connection is vibration
secure. You may connect cables with a cross-section of 0.08 mm2 to 2.5
mm2. You may use flexible cores without end case as well as stiff wires.
The wires are fixed at the spring clamp contacts as follows:
+

2

Chapter 2 Deployment OP 03

L+

M

M

DC24V

for screwdriver
for wires

The illustration on the left side shows the steps of the cabling seen from
top.
• To conduct a wire you plug a fitting screwdriver obliquely into the
rectangular opening like shown in the picture.
• To open the contact spring you have to push the screwdriver in the
opposite direction and hold it.
• Insert the de-isolated wire into the round opening. You may use wires
with a cross-section from 0.08mm2 to 2.5mm2.
• By removing the screwdriver the wire is connected safely with the plug
connector via a spring.
Please note as soon as the OP 03 is connected to the CPU by means of a
MPI cable, which carries power supply, the external power supply must be
disconnected again.

Prepare OP 03 for
data transfer

If the standard project is active in the OP 03, the OP mode "Operat. mode
Transfer" may be set by System > OP-Mode after entering the password
.
"100" and confirmed by
With "Ready for transfer" the OP 03 is now waiting for data.
If the standard project is not just available there is the following possibility
to reach the "Setup menu":
Push the key combination

+

the "Setup menu" is active. With
and press
data.

and turn on the OP 03 until

select "Perform Download from PC"

. With "Ready for transfer" the OP 03 is now waiting for

This process may be aborted with
HB116E - OP03 - Rev. 07/50
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Start transfer in
OP-Manager

Start at the PC the OP-Manager with your project.
There is an online access to the OP 03 only if the OP-Manager works with
a licensed version.
Start the transfer function by clicking on

in the OP-Manager, choose

"MPI", if needed set the according COM port via

and the baud

and confirm the project engineering.
rate to 38400, click on
After the transfer, the OP 03 starts with the new project.
Disconnect external
power supply when
using VIPA 670-0KB00

The delivered cable (VIPA 670-0KB00) carries power supply, so the
external power supply must be disconnected from the OP 03, before
connecting to this cable.

Operation

Connect after transmission the MPI jack of CPU and OP 03 by means of
the delivered MPI cable. As soon as the power supply of the CPU is
switched on, the OP 03 is power supplied via MPI and starts automatically
with the project.

Operation
OP-Manager

CPU

OP 03
Operator Panel

CPU

OP03
ESC

,

+/F1

F2

F3

1

2

6

7

F4

3

8

5

9

0

SHIFT

ENTER

MPI

VIPA 670-0KB00

not permitted
OP-Manager

MP2I

F5

4

DC 24V

OP 03
Operator Panel

CPU
CPU

OP03
ESC

,

+/F1

F2

F3

F4

2

3

4

5

7

8

9

0

MPI

MP2I

F5

1

6

SHIFT

ENTER

VIPA 670-0KB00

RS232
Green Cable (VIPA 950-0KB00)
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With this transfer method the OP 03 is powered by the power supply of the
CPU when connecting this by the delivered MPI cable (VIPA 670-0KB00) to
the CPU.
There is an additional MPI jack at the cable. Here a MPI converter cable
may be attached.
The MPI converter cables are available from VIPA in different versions. At
the PC side the MPI converter cable may be connected to the RS232
interface or the USB slot depending on the version.

OP 03

OP-Manager

CPU

Operator Panel

OP03
ESC

CPU

,

+/F1

F2

1

F3

2

MP2I
6

7

F4

F5

3

4

5

8

9

0

MP2I
SHIFT

ENTER

MPI

VIPA 670-0KB00

MPI converter

Prepare OP 03 for
data transfer

If the standard project is in the OP 03, you may set the OP mode "Operat.
mode Transfer" via System > OP-Mode, entering the password 100 and
.
confirm with
Now the OP 03 awaits data with "Ready for Transfer".
If the standard project is not yet present the setup menu may be connected
with the following proceeding:
Push the key combination
+
+
on the OP 03 and turn it on
again. Hold the keys until the OP 03 branches to the "Setup menu".
Choose with
"Perform Download from PC" and push
The OP 03 now awaits data with "Ready for Transfer".
This operation may always be aborted by

Start transfer at
OP-Manager

.

.

Load the OP-Manager with your project on your PC. You may only access
the OP 03 online, if you work with a licensed version.
Call the transfer function with a click on
.
Select MPI and set the transfer parameters like COM port, baud rate 38400
via

and confirm your entry.

configuration is confirmed and the transfer is started. After
With
the transfer, the OP 03 starts with the new project.
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Operating the OP 03
Turn on

The OP 03 is to be connected to the CPU by the delivered cable (order no.
VIPA 670-0KB00). As soon as the power supply of the CPU is turned on,
the OP 03 is power supplied via MPI and starts automatically.

Operation via
keyboard

In delivery state, the OP 03 is loaded with a standard project where all
functions that are required for the operation are integrated.
You reach the menu res. the screens of a loaded project by pushing
after start-up.
The following keys serve the navigation:
res.

Navigation to the previous res. next screen

res.

Navigation to the previous res. next screen

Push also

to navigate horizontal within a screen with

res.

and choose with
res.
characters from a character set
that you can not insert via keyboard e.g. at hex entry for example.
With

you leave and accept the date entry.

you abort an entry res. you come back to the next
With
superordinated menu level.
The keys
...
may be programmed as soft keys with screen
depending functions via your engineering tool.
The access to the soft keys can be configured with or without additional
key. This is set via
from Siemens.

in the OP-Manager from VIPA res. ProTool

allows you to change the numeric sign res. with
a comma.
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By pushing the key combination
+
+
before turning on, you
reach the SETUP where you can set basic properties.

Set display contrast
The display contrast is set in the SETUP using

+

res.

.

Navigation
The navigation happens with

res.

, the selection with

.

leaves the SETUP.

Data transfer and
error diagnosis

The SETUP includes the following functions:
• Setup default prog
This function overwrites the recent project with the standard project.
• Download from PC
This function prepares the OP to receive project engineering data via
MPI from the OP-Manager.
In delivery state, your OP has the MPI address 1.
To control the MPI address you may also leave the SETUP with 2x
and request MPI address and baud rate via

SYSTEM

>>
MPI-ADR
. The alteration of these values is only
permissible via the project engineering in the OP-Manager.
Afterwards you have to shut down the OP and restart it with the key
combination above to enter the SETUP again.
Choose Download from PC and push

.

After the data transfer has been finished, the data is proofed and stored
in the memory. If everything is OK, the OP starts with the new project.
• Display error log
All error codes that are stored in the OP are monitored.

HB116E - OP03 - Rev. 07/50
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Firmware update of the OP 03
Overview

The OP 03 allows you to update the firmware via an update software and
the Green Cable from VIPA.
The 2 last recent firmware versions can be downloaded in the service area
of www.vipa.de and from the ftp server ftp.vipa.de.

Attention!
Please be very careful with loading a new firmware. Under certain
circumstances you may destroy the OP 03, for example if the voltage
supply is interrupted during transfer or if the firmware file is defective.
In this case, please call the VIPA hotline!
Please also regard that the update version has to be different from the
existing version, otherwise no update will happen.

Read firmware
version

If you didn't execute a firmware update before, you may find the recent
firmware version on the label on the backside of the OP 03. Otherwise
using the standard project the version is displayed at the LCD.

Load firmware via
ftp.vipa.de

To display ftp-sites in your web browser you may have to adjust the
following settings:
Internet Explorer (ftp access ability since V. 5.5)
Options > Internet options, register "extended" in the area "Browsing":
- activate: "Activate directory view for ftp-sites"
- activate: "Use passive ftp..."
Netscape (ftp access ability without further adjustments since V. 6.0)
If you have problems with the ftp access, please ask your local system
operator.
To download the firmware file, order no. and version no. (HW) are required.
These ID numbers mark the storage directory of the concerning firmware.
For example: The firmware file of an OP 03 with the order no. 603-1OP00
and HW no. 1 is stored under the file name 603-1op00_a1.xxx (xxx is the
according firmware version).
• Type the address www.vipa.de.
• Click Service > Download > Firmware Updates in the navigation bar and
download the according firmware for your OP.
• Extract the zip-file into the wanted directory on your PC.
• If you want to execute the update with the Green Cable, an update
software is required that you may download under "Software Tools" in
the download area. Start the Updater with cpu_up.exe
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to 0.
to 1.
to 2.

Connect the COM interface of the PC and the MP2I jack of your
OP 03 via the Green Cable.
Type the COM interface (you should not alter the setup).
Turn off the power supply of your OP 03, push the
key and
turn on the power supply again.
Now the OP 03 is ready for the firmware update. Nothing is shown
on the display.

to 3.
to 4.

Click on
in the updater.
A connection to the OP 03 is established and shown via the
message "connected".
If an error message appears instead, repeat the steps above with
another COM interface.

to 5.

At error free connection click on
now prepared for data transfer.

to 6.

A click on

. Your OP 03 is

opens a file selection window. Choose

.
the according firmware and start the download with
If the error message "The selected file doesn't fit to your
hardware" appears you may have been tried to download a
firmware that is not compatible to your OP 03. With a valid
firmware version, the update process starts. This process may last
several minutes and is shown in a process bar.
After the download, the following window should appear:

to 7.

Turn off the power supply of your OP 03, disconnect the Green
Cable and turn on the power supply again. Now the OP 03 is
ready with the new firmware.

If your OP 03 does not start anymore, an error occurred during the
firmware update. Please call the VIPA hotline.
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Chapter 3

Functions operator panel

Outline

This chapter informs you about the functionalities of the operator panel.
Especially referred to is to the functions that are part of the standard
project.
The text describes how you access screens, use operating keys, react to
messages, alter values and use the password protection.

The following text describes:
• Work with screens
• Standard project
• Evaluation of screen number and keyboard input
• Reaction to messages
• Using the clock, timer and counter
• Operating modes Online, Offline, Transfer
• Display and alter values
• Password protection

Content
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Screens
Overview

To monitor the process execution, the operator panel uses "Screens". A
screen consists of a matrix of 2x20 characters that corresponds to the size
of the display.
You may program this screens in the OP-Manager.
Screens collect logical matching process values and give you an overview
over a process or an installation.
The screens allow you to enter process values and thus control the
process.
To structure your process, you may develop up to 40 screens with up to 20
entries where you can branch if needed.

Screen
components

Screens consist of entries. Every screen can contain several entries.
Always one entry is shown per display page.
If existing, a not ready programmed row is monitored in the display as
empty. A screen may include the following elements:
• Message and description texts like e.g. explanations for the user. The
texts may also contain information about the soft key functions.
• Fields for in- and output of date, time, effective value and set point.
• Definitions of the soft keys that are programmed to different function
calls depending on the screen.

Alter screen

You may enter values in a screen. Use the following approach:
• Choose the screen you want to alter.
→ The cursor jumps to the first input field.
• Move the cursor with
the wanted value.

res.

to the according field and enter

.
• Confirm your entry with
• Repeat this for all values that you want to alter.
• Finish the change e.g. with ESCAPE.

Screen
contents list

3-2

During the operation, you may access screens via programmed soft keys
or via integrated special functions.
At the project engineering in the OP-Manager, the main screens are
collected in a screen contents list under "Screens" and listed with name
and screen number.
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Automatical
update of values

During the project engineering in the OP-Manager you may set a poll rate
for every variable that defines the interval for the variable update.
Please regard that the lowest poll rate is decisive for the complete screen
entry.
To optimize your project engineering, you should:
• program the poll rate as high as possible (min. 1 second).
• program low poll rates only for critical variables.
• refer to only one CPU per entry. The OP 03 allows a max. of 2.

In- and
output fields

Output fields display effective values of the control in numeric or symbolic
format. Input fields enter set points in numeric or symbolic format. In input
fields you can see the blinking cursor.
For symbolic in- and output fields, you may configure up to 256 texts where
you can choose from via a selection field. The selected text is taken over.
For numeric value entries, configured number formats res. limit values are
valid, regarding the number of digits in front and behind the comma.

Screen level and
message level

The operator panels have two different operating levels that you may use.
Screen level:
The screen level serves the selection, operation and execution of functions.
You reach the screen level via
. The first screen is the so-called start
screen. From here, you can branch, depending on the project engineering,
into other screens. The screens display recent process values, you may
enter values and initialize functions via the soft keys.
.
Jump back to the message level with
At messages, the operator panel branches into a temporary message level.
As soon as you acknowledge every message with
, the panel jumps
back to the previous screen.
If several messages are waiting for acknowledgement, you may switch
res.
.
between them with
Message level:
The message level displays recent messages like incoming operating and
system messages.
After start-up, the operator panel switches to the message level.
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Standard project with standard functions
Standard project
after RESET

Screens
+

Counter
Timer

Functions in
standard screens

The project engineering tool OP-Manager allows you to load a "standard
project". This project contains all functions available via standard screens.
This project remains active also after a RESET of the operator panel.
As long as no project engineering is loaded res. after a RESET, the
following standard project is activated with English dialogs.

System

StatVAR
+

OP-Mode
Language
Dat/Time
MPI-Adr

+

StatVar

ForceVAR

Password

+

+

ForceVar

Logout
Edit

The call of screens of the standard project happens via soft key.
Depending on the project engineering, you have to use the
additional to the soft key.
The following standard screens are part of the standard project:

key

• Screens
Via "Screens" you can enter a screen contents list that shows all
screens that have been marked at the project engineering with the
attribute "Screen to Directory" (Contents list). Without further
programming, the contents list displays the two standard screens
"Counter" and "Timer".
• System
"System" allows you the access to the system settings. You may
choose, for example, the operating mode, the language or set date and
time.
• StatVAR
This function starts the PG function STATUS VAR that allows you to
display operands of the destination CPU.
• ForceVAR
This function starts the PG function STEUERN VAR that allows you to
display and alter operands of the destination CPU.
• Password
Here you may set up to 20 passwords for up to 9 different password
level.
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Process depending operation
Screen hierarchy

The project engineering allows you to adjust the screen hierarchy to the
installation specific needs by adding, coupling or removing screens.
During the project engineering you define the start screen, structure,
sequence of the coupling, entry in the contents list and the return
destinations.
The branch into several screens happens via soft keys and programmed
return destinations.

Evaluation of the
screen number

The screen number area is in the CPU. Here the operator panel stores the
number of the recent called screen.
As soon as the CPU writes a number into this are, the according screen is
displayed at the operator panel.
If you want to use the screen number area, you have to configure this in
the OP-Manager. Create the screen number area in the project object
group via the register "Area Pointer".
Choose the register "Area Pointer" and create a new object with the type
and assign a DB or a bit memory area.
"Screen number" via
The screen area consists of a double word and has the following structure:

Double word

Byte 0

1. DW (Display content)
2. DW (CPU entry)

Bit 7
Bit 7 = 1 (ID for special screen)
Bit 7 = 1 (ID for special screen)

Byte 1
Bit 0 ... 6
Bit 0 ... 7
Screen number Entry number
Screen number Entry number

The first data word is filled by the operator panel with information about the
monitored display content.
As soon as the CPU writes a screen and entry number into the second
data word, the according screen is displayed at the operator panel with the
concerning entry.
The entry FFFFh in the 1. or 2.DW marks the message level.
As soon as a 0 is in the 2.DW, your operator panel is ready for employment.

HB116E - OP03 - Rev. 07/50
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Special screens

When the highest valued bit is set in the DW of the screen number area
("1"), a special screen is displayed.
When the highest valued bit in the DW of the screen number area is
deleted ("0"), a user specific screen is displayed.
Screen number
0
25 (19h)
26 (1Ah)
30 (1Eh)
31 (1Fh)
35 (23h)
36 (24h)
55 (37h)
56 (38h)

Example for
screen selection
via CPU

Manual VIPA HMI

Special screen
Screen contents list
Status Variable
Control Variable
Language selection
Change operating modes
Set Date/Time
MPI address/Baud rate
Password Login
Password Edit

An example shows you the screen selection of screen number 2.

The operator panel shows a not specified screen.

1. DW
2. DW

Screen Entry No.
No.
x
x
x
x

To recognize and overtake an alteration, your user application
must write a "0" to the 2. DW of the screen number area.

1. DW
2. DW

Screen Entry No.
No.
x
x
0
x

At the earliest after one poll cycle (1 second) your user
application may transfer the value 2.

1. DW
2. DW

Screen Entry No.
No.
x
x
2
x

1. DW
2. DW

Screen Entry No.
No.
2
x
2
x

The operator panel recognizes the change from 0 to 2 and
displays the according screen. For control purposes, the screen
number is written to the 1. DW.

3-6
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Keyboard input

At the front side there is a foil keyboard with 18 short click keys. 8 keys
serve the navigation and 10 are numerical keys where 5 can be
programmed as function keys.
When you push a function key, a bit is set into a bit memory byte of your
CPU. By requesting the bit memory byte in your PLC application, you may
react to an entry.
The numeric and cursor keys are provided with a repeat function. If you
hold the key down, the key is after a short delay time repeated as long as
you push the according key.
Note!
If you push several keys fast consecutively, some entries may get lost. Not
received keys are signalized via an acoustic signal.

...

+

...

Numerical keys
The numeric keys enter numeric digits (0...9).

Soft keys (F1 to F5)
The numeric keys 1 ... 5 may be configured as soft keys, i.e. this keys can
be programmed with screen depending functions. You enable the soft key
functions by pushing the SHIFT key and simultaneously one of the keys 1
to 5.

SHIFT key
Switches to the second function of double programmed keys.
pushed simultaneously with another key.

is

Math sign key
allows you to change the math sign res.
comma.

+

to set a

ENTER key (Return)
This key confirms and finishes an entry. ENTER also switches from the
message to the screen level.

HB116E - OP03 - Rev. 07/50
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ESCAPE key
This key allows you to:
• clear field entries as long as they have not been confirmed with
.
• branch back from the start screen to the message level or within a
screen to a defined jump back destination.
• interrupt the leafing of messages and display of the recent message.
• leave a system message.

Navigation

For the navigation, the following keys are available:
res.

navigation to previous res. next screen

res.

navigation to previous res. next screen

Push

additional

with

res.

to

navigate

horizontal

within

a

screen

and to choose a character from the character set that

can not be entered via keyboard with

res.

e.g. at Hex input.

Enter the SETUP
Push simultaneously the key combination
+
+
before
turning on and during the boot time to reach the SETUP where you can
alter basic functions.
The navigation happens with

res.

, The selection with

.

leaves the SETUP again.

Set display contrast
The display contrast is set in the SETUP using

3-8
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The SETUP provides the following functions:
• Setup default prog
This function overwrites the recent project engineering with the standard
project.
• Download from PC
This function enables the operator panel to receive engineering data
from the OP-Manager via MPI.
In delivery state your operator panel has the MPI address 1.
To control the MPI address you may also leave the SETUP with 2x
and display via
SYSTEM
>>
MPI-ADR
the MPI address and baud rate. Alteration of this values happens in the
OP-Manager via the project engineering.
To return to the SETUP, you have to turn off the operator panel and turn
it on again pushing the shown keys.
Choose Download from PC and push

.

After the data transfer has finished, the data is proofed and stored in the
memory. When executed with OK, your operator panel starts again with
the new project engineering.
• Display error log
All error codes stored in the operator panel are displayed.

Note!
Please regard that some functions like e.g. "Download from PC" are
already included in the standard project. By including it into your project,
you may use them as soft key functions without setup call.

Soft keys
...
can be programmed as soft keys in your project
The keys
engineering tool and be configured with screen depending functions.
The access to the soft keys can be programmed for usage with or without
additional

HB116E - OP03 - Rev. 07/50
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You can reserve a data area in your CPU for the system keyboard. Every
key uses one Bit. By according evaluation your user application may react
to key pushes.
If you want to create a data area for the system keyboard, you have to
configure it in the OP-Manager. Choose for this the register "Area Pointer"
in the project object group.
and
Create a new object of the type "System Key Assignment" with
assign a DB or bit memory area. The keyboard data area consists of a
double word and has the following structure:

Bit

7

6

Byte 0
5
4
3

2

1

0

7

6

5

Byte 1
4
3

9

8

7

6

5

4

2

1

0

2

1

0

1. DW
2. DW

Sum bit

3

The sum bit 7 in the 2. DW serves as control bit. At every transfer of the
keyboard image from the operator panel to the CPU it is set to the value
"1" and should set back from your user application after evaluation.

Value entries

Input fields allow you to enter values that are transferred to the control.

Approach

1. Branch into the wanted screen and there to the according screen entry.
2. Use the cursor keys to select the wanted input field.
3. Enter the wanted value. Depending on the project engineering of the
field you may enter values as:
- numeric values
- alphanumeric values
- symbolic values
4. Confirm your entry with

.

Clear a wrong value with
.
The original value it then set back into this field. Repeat the entry with
the correct value.
5. Leave the screen entry with

3-10
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Input fields that allow the entry of numeric values are filled via the number
field of the keyboard digit per digit. An already started input can only be
confirmed with

or aborted with

.

To enter a decimal value, use
+
.
An already entered value is automatically deleted.
The input is linked to the right side. Entered digits are added right. Input
fields in bit pattern format are linked to the left. Existing values are
overwritten from the left.
and

Move here the cursor with

res.

.

Number formats
and Limit value
evaluation

The OP-Manager allows you to set limit values and number formats for
numeric input fields. These fields execute a limit value evaluation. The
values you enter are only accepted if valid and within the defined range. If
you enter a value exceeding the range, a system message appears. After
abort, the previous value is displayed.
If the format of a numeric field has been set to a certain number of digits
after the comma, empty places are filled with a 0, too many digits are
ignored after acknowledgement.

Alphanumeric
values

Alphanumeric values contain digits as well as characters. Enter the digits
like shown above.
If you want to enter a character at the cursor position, you have to activate
the alphanumeric character set. Push
character via

Symbolic values

res.

and choose the according

.

Symbolic values are texts res. value that can be chosen from a selection
list.
Push
with
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res.

. Confirm

.
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Messages
Overview

Events and states of the control process are shown on the operator panel
as messages.
Normally, a message consists of a static text and if wanted additionally
variables. Messages can be:
• configurable operating messages that are initialized by the CPU,
• (error-) system messages that are initialized by the operator panel.

Operating
messages

Operating messages contain process related information in form of static
text and variable fields like e.g. messages about states or processes of an
installation. Here you may display e.g. recent control effective values in
numeric or symbolic format. You may configure operating messages as
status messages as well as operating hints.

Configure
operating
message

The output of a message happens event triggered. As soon as an event
takes place in the specified CPU, the according message is shown, sorted
. Please regard that
after priority. Acknowledge every message with
you first have to configure the event in your project object group in the
register "Area Pointer", if you want an event to cause a message.
Select the register "Area Pointer" and create a new object of the type
. Assign a DB or bit memory area. For every bit
"Event Messages" via
in the operating message area you may configure one operating message.
The operating message area can be divided in up to 4 address ranges.
The address ranges need not to be in sequence. The assignment of
message number and bit number happens automatically like shown in the
picture:

16 15 14 13 12 11 10 9

8

7

6

5

4

3

2

1

Message no

15 14 13 12 11 10 9

7

6

5

4

3

2

1

0

Bit number

8

32 31 30 29 28 27 26 25

24 23 22 21 20 19 18 17

15 14 13 12 11 10 9

7

8

6

5

4

3

2

1

0

Message no
Bit number

48 47 46 45 44 43 42 41

40 39 38 37 36 35 34 33

Message no

15 14 13 12 11 10 9

7

Bit number

8

6

5

4

3

2

1

0

Address
range

Address
range

.
.
.
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Standby message

When your operator panel is on message level and there is no message
waiting, "Standby" is displayed as operating message. The standby
message is stored in the firmware and contains per default release version
and device type. You may change the content of the standby message via
the message number 0 in the OP-Manager. You may display altered text,
date and time but no variables.

System
messages

System messages display internal operating states of the operator panel.
They may monitor e.g. wrong handling or communication problems. This
message type has the highest display priority. If a failure occurs, the
recently displayed operating message fades and the system message is
shown.

"Heavy"
system message

A "heavy" system message requires a reboot of the operator panel.

Normal
system message

All other errors cause normal system messages. The display of a normal
. You return to the
system message can be aborted at any time with
screen before.
The OP-Manager allows you to deactivate the output of system messages
and preset the display duration.
After timeout the operator panel jumps automatically back to the previous
screen.

Display priority

Example

System messages always have the highest display priority.
Operating messages are displayed after message priority.
You may configure the priority for the operating messages during the
project engineering, depending on the importance from 1 (low) to 4 (high).
If several messages with the same display and message priority occur, the
latest message is always shown first.
Reception sequence
1. Operating message A (Priority 2)
2. Operating message B (Priority 3)
3. Operating message C (Priority 2)
4. System message A

Display sequence
1. System message A
2. Operating message D (Priority 4)
3. Operating message B (Priority 3)
4. Operating message C
(new with Priority 2)
5. Operating message D (Priority 4) 5. Operating message A
(older with Priority 2)

HB116E - OP03 - Rev. 07/50
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The message buffer contains the last 50 messages in sequence of their
reception.
If the message buffer is filled, the oldest message is deleted. If there are
more than 50 messages (message rush), only the recent 50 are shown in
the message buffer. It is not possible to monitor more than 50 messages.

Scrolling
If no system message is waiting, you may scroll up down with

res.

. between waiting operating messages, which are displayed in the
sequence of their reception and sorted after priority.
Shows the next older (lower priority) message. After the oldest message of
one priority group, the newest message of the next lower priority is
displayed. "↓↓↓" marks the end of the messages.
Shows the previous (higher priority) message. After the newest message of
a priority group the oldest of the next higher priority group is displayed.
"↑↑↑" marks the end of the messages.
Jumps back to the recently waiting message. This automatically happens
also after 1 minute delay time.

Languages
•
•
•
•
•
•
•
•
•

German
English
French
Italian
Spanish
Italian
Swedish
Norwegian
Danish

3-14

Via the option "Language Assignment", the OP-Manager allows you to
select up to 3 of 8 languages for screens and operating messages. Choose
the according language in the OP-Manager and configure the according
screens and messages. Now you may adjust screens and message text in
the available up to 3 languages.
The texts for the system messages in 8 languages are fix integrated in the
operator panel. The text output depends on the language that is set at the
operator panel.
You may choose one of the 3 configured languages at any time during
operation. To switch the language, you may choose System > Language
enter your password (Standard: 100) and change the language. The
selected language must be programmed before.
After the language selection, the operator panel restarts and all language
related texts are displayed in the selected language.
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Timer and Counter
Overview

Your operator panel allows you access to timer and counter of the CPU.
You may only set time res. counter values. Start res. stop of timer and
counter are not possible.
Examples for that you may see in the standard screens. The access to
timer and counter happens via the standard screens "Timer" and
"Counter".

Effective value
and set point

You may display the recent effective value for every programmed and in
the CPU activated timer function. Examples are to find in the standard
project under screens. Choose the standard screen "Screens" → "Timer" in
the standard project.
The display shows:
Set point
0.00
Timer 1
Effective value 0.00
The 1. row shows the recent timer value. The 2. row allows you to enter a
set point.
leaves the screen.

Time base

The common time base for every timer is configurable (10ms, 100ms, 1s or
10s). Your operating device recognizes the chosen time base and
nominates the display value to seconds.

Date and time

The operator panel process date and time internally.
Please regard that the OP 03 has no integrated clock. You have to enter
date and time after every reboot.

Alter date and time

The standard project allows you via System > Dat/Time to alter date and
res.

time. Switch between date and time with
field you may navigate with
Confirm the entered value with

HB116E - OP03 - Rev. 07/50
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.

3-15

Chapter 3 Functions operator panel

Manual VIPA HMI

Interface area to external CPU - only OP 03
Overview

The definition of an interface area is only necessary at employment of an
OP 03 if you want to use the following functions:
• Synchronization of date and time between CPU and OP 03,
• Boot recognition of the OP 03 in the CPU user application.
You may configure an interface area via the OP-Manager. This area is
used by the OP 03 to synchronize date and time with the CPU res. for the
login recognition of the OP 03 at the CPU.
The according area has to be provided with date and time by your user
application. The access of the OP 03 happens automatically in fix intervals.

Configure
interface area

Create a new object of the type "Interface Area" in the register "Area
and assign a DB or bit memory area.

Pointer" via

Structure

The interface area has a length of 32Byte and has the following structure:

Address
Bit 7 ... 0
n+0
Date/Time
n+1
Control/Return bits
n+2
...
reserved
n+12
n+13 Connection recognition
n+14
Reserved
n+15
n+16
Time BCD coded
n+17
n+18
...
reserved
n+20
n+21
n+22
Date BCD coded
n+23
n+24
n+25
...
reserved
n+31

3-16

Bit
2
0

0=Data updated by CPU, 1=OP requests data
0=OP not present, 1=OP started

7 ... 0 00 as soon as CPU is connected
7 ... 0 Hour (0...23)
7 ... 0 Minute (0 ... 59)
7 ... 0 Second (0 ... 59)

7 ... 0
7 ... 0
7 ... 0
7 ... 0

Day of Week (1=Su, 2=Mo, 3=Tu, ... 7=Sa)
Day (1 ... 31)
Month (1 ... 12)
Year (0 ... 99)
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Synchronize
Date and Time
Bit 2 of Byte 0,
Byte 15 ... 17,
Byte 21 ... 24
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To synchronize date and time you have to execute the following steps:
• Create an area pointer of the type interface area for the OP 03 via the
OP-Manager. Choose "Area Pointer" and create a new object of the
. Assign a DB or bit memory area. Transfer
type "Interface Area" via
your project into the OP 03.
• Write via your user application date and time into the following bytes of
your interface area:
Address Bit 7 ... 0
n+0
...
n+14
n+15
n+16 Time BCD coded
n+17
n+18
...
n+20
n+21
n+22
Date BCD coded
n+23
n+24
n+25
...
n+31

Entry

Hour (0...23)
Minute (0 ... 59)
Second (0 ... 59)

Day of week (1=Su, 2=Mo, ... 7=Sa)
Day (1 ... 31)
Month (1 ... 12)
Year (0 ... 99)

• Release the data for the synchronization by setting Bit 2 of Byte 0 to 0.
After start-up and then in defined intervals, the OP 03 synchronizes date
and time. As acknowledgement for the CPU, the OP 03 sets Bit 2 of
Byte 0 to 1 after synchronization.

Boot recognition in
the user application
Bit 0 of Byte 1

As soon as an OP 03 is connected to a CPU and an interface area is
configured, the OP 03 sets Bit 0 of Byte 1 of the interface area. The reset
of Bit 0 marks the restart of the OP 03 for your user application.

HB116E - OP03 - Rev. 07/50
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Operating mode
Overview

Your operator panel is provided with integrated system functions that allow
you to set the operating mode of the panel.
The following operating modes are available:
• Online
• Offline
• Transfer

Online

Your operator panel always starts in the operating mode "Online". The
operating mode "Online" means a logical connection between operator
panel and CPU res. it is tried to establish a connection.

Offline

"Offline", your operator panel works separately from the CPU. No
connection establishment is tried. Thus allows you to suppress CPU error
messages for test purposes.

Transfer

The operating mode "Transfer" initializes the operator panel to receive a
project engineering via MPI. As communication parameter, the parameters
defined at "MPI-Adr" in your operator panel are used.
When your operator panel is in the operating mode "Transfer", you may
connect your PC via MPI and transfer your project online from the OP.
Manager. You may interrupt the transfer at any time via
For the connection, you may use either an MPI adapter or the "Green
Cable" from VIPA for a serial point-to-point connection. When using the
Green Cable you have to set the transfer rate in the OP-Manager to
38400 Baud.
Note!
Please regard that the online project engineering is only available with a
licensed version of the OP-Manager!

Navigation

In the standard project, the operating mode setting is under System >
OPMode.
Change the operating mode with
+
res.
. This function
requires a password. The password of the standard project is 100.
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StatVAR and ForceVAR
The functions StatVAR and ForceVAR allow you to monitor res. alter
operand values of a connected CPU. So you may alter control operands
directly during online operation.
• StatVAR monitors the operands of the CPU
• ForceVAR monitors the operands of the CPU and allows you to alter
them. You may not use ForceVAR to fix values but only alter them
during runtime.

Overview

Note!
The functions StatVAR and ForceVAR are to find in the standard project.

In the standard project these functions are password protected. The
password is 100. Starting from the message level, you see both functions
like shown in the menu structure:

Start

Screens
+

Counter
Timer

MPI address

StatVAR

System
+

OP-Mode
Language
Dat/Time
MPI-Adr

+

StatVar

ForceVAR

Password

+

+

ForceVar

Logout
Edit

After the call of StatVAR res. ForceVAR you need the MPI address of the
destination CPU. Default address is address 2.
At the OP 03, this 2 functions give you the opportunity to connect an
additional CPU to complete the already configure ones.
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After entering the MPI address, you reach the operand field with the cursor
key

.

+
Push
display.
field.

and choose with

or

the data type that you want to

sets automatically the according data format in the format

brings you to the numeric input field. Use the numeric key
The key
block to type the number of the operand to monitor res. at ForceVAR the
.
operand to monitor and alter and confirm with
Every operand value that shall be monitored or altered has to be defined in
a "Screen". You may create up to 10 screens.
Within a screen res. a value field you navigate the blinking cursor with the
arrow keys.
Confirm your entries for every field with
. The values of the displayed
operands are shown in the preset format in the value field.

+

The key combination

+

deletes single rows.

After you've altered the operand list, the values in the control must be
updated. This happens immediately after the verification of a single value.
When you press the enter key again after the last confirm of your entries,
the new values are transferred to the control.

Note!
During the status update, a blinking * is shown in the right upper corner of
the display. If the star is not blinking, no logical connection to the control is
established.
During the update process, no entries are permissible.
You may interrupt the update at any time via

3-20
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Password protection
Overview

To avoid unauthorized access, the operator panel provides an integrated
password protection. This includes the definition of passwords for up to 8
password level. The assignment of the password levels happens in the OPManager. With raising importance of the functions you may set a password
level from 0 to 9 at the project engineering of soft keys.
Enter Level 0 to deactivate the password request.
A password of the level 9 gives you access to all other password levels.
This "Supervisor-Password" is set in the project engineering.
The passwords for the levels 1 to 8 are exclusively set in the operator
panel. The screen "Password" is required in your project (see standard
project).

Set SupervisorPassword

The Supervisor-Password gives you access to all functions of your
operator panel. The Supervisor-Password is transferred to the operator
panel together with the project. To enter a Supervisor-Password click on
in your project. The following dialog window appears:
Set a password under "Supervisor" and
define via "Logout Time" how long after
the login the password will be valid.

Set
password level

You may set a password level for every soft key definition like shown in the
picture.
Please regard that the password levels
for integrated standard screens of the
operator panel are fix like e.g.:
Level 9: Password Edit, OP-Mode
Level 8: ForceVAR
Level 0: StatVAR, Password>Logout
More detailed information see following
page.
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Precondition
You've included the screen "Password" into your project and you know the
Supervisor-Password.
Approach
• Load your project into the operator panel.
• Press
and navigate to the screen "Password". Via "Edit" you
reach the password dialog. The password alteration is protected with the
Supervisor-Password. In delivery state, the password is 100. Please
additional to the digit 1

regard that you may have to push
depending on the project basic settings.

.
• Enter the password and confirm with
Now you reach a table where you may enter a password for every level.
For you may store up to 20 password assignments in the table, you may
also assign more than one password to a level. The password must have
at least 3 digits and max. up to 8 digits. Characters and leading zeros are
not permissible. The table has the following structure:

No.
0
1

Password
______100
_________

Level
9
0

(Supervisor-Password)

.
.
.

20

Navigation and
delete password

_________

0

The navigation happens with the arrow keys. You have to confirm every
entry with
. To delete a password, write a 0 (zero) over the password.
The Supervisor-Password cannot be deleted.
finishes the password entry and brings you back to the password
screen. Via "Logout" you activate the passwords.

Fixed password
levels

Please regard that the password levels for the following integrated
standard screens are fixed in the operator panel:
Level 9:
Level 8:
Level 6:
Level 4:
Level 2:
Level 0:

3-22

Password Edit, OP-Mode
ForceVAR
System>MPI-Adr
System>Dat/Time
System>Language
Screens, StatVAR, Password>Logout
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Chapter 4

General installation guidelines

Overview

"With General installation guidelines" you get information about the
interference-immune installation of Programmable Logic Controls (PLC).
Here we describe possible paths in which interference can enter the
controller, how you ensure the electromagnetic compatibility (EMC) and
how to approach shielding and screening issues.
The following text describes:
• EMC and possible interference sources
• Basic rules for ensuring EMC
• EMC-orientated assembly and cabling
• Guidelines for the installation of couplers

Content

Topic
Page
Chapter 4
General installation guidelines ...................................... 4-1
Basic rules for the EMC-equitable assembly of installations................. 4-2
EMC-equitable assembly...................................................................... 4-6
EMC-equitable cabling ......................................................................... 4-7
Special precautions providing high noise immunity ............................ 4-11
Checklist for the EMC-compliant installation of controllers ................. 4-12
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Basic rules for the EMC-equitable assembly of installations
What is EMC?

The term electromagnetic compatibility (EMC) refers to the ability of an
electrical device to operate properly in an electromagnetic environment
without interference from the environment or without the device causing
illegal interference to the environment.
The Operation Panels are developed for applications in harsh industrial
environments and complies with EMC requirements to a large degree. In
spite of this you should implement an EMC strategy before installing any
components, which should include any possible source of interference.

Possible sources
for disturbances

Electromagnetic interference can enter your system in many different ways:

Interference is coupled into your system in different ways, depending in the
propagation medium (conducted or not conducted) and the distance to the
interference source.
We differentiate between:
•
•
•
•
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galvanic coupling
capacitive coupling
inductive coupling
radiated power coupling
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Coupling
mechanisms and
interference
sources

The following table shows the four different coupling mechanisms, their
causes and possible interference sources.

Coupling mechanism
Galvanic coupling
Disruptor

Cause
Galvanic or metallic coupling
always occurs when two
current circuits have a
common line

galvanic
coupling line
Automation
System

Capacitive coupling
Disruptor

capacitive
coupling line

Typical source
• Pulsed devices
(Net influence from
transducers and foreign net
devices)
• Starting motors
• Different potential of
component cubicles with
common current supply
• Static discharges

Capacitive or electric coupling
occurs between conductors
with different potential.
The coupling is proportionate
to the time characteristics of
the voltage.

• Interference through
parallel signal lines
• Static discharge of the
personnel
• Contactors

Inductive or magnetic coupling
occurs between two current
active line loops.
The magnetic flows associated
with the currents induct
interference voltages.
The coupling is proportional to
the time characteristics of the
current.

• Transducers, motors,
electric welding devices
• Parallel net cables
• Cables with toggled
currents
• Signal cable with high
frequency
• Unused coils

Automation
System

Inductive coupling
Disruptor

wanted signal

inductive
coupling
line

Automation
System

Radiate power coupling
Disruptor

One talks of radiate power
• Sender in the neighborhood
coupling, when an
(e.g. walkie-talkie)
electromagnetic wave meets a • Sparking lines
line circuit.
(sparking plugs, collector of
The hit of the wave inducts
electric motors, welding
currents and voltages.
devices)

radiated
coupling
line
Automation
System
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In many cases, adherence to a set of very elementary rules is sufficient to
ensure EMC. For this reason we wish to advise you to heed the following
rules:
During the installation of your automation units you should ensure
that any inactive metal components are grounded via a proper largesurface earth
• Interconnect any inactive metal components via low-impedance
conductors with a large cross-sectional area.
• Execute screw connections at coated and anodized metal parts either
with special contact washer or remove the isolating protective film.
• Install a central connection between the chassis ground and the
grounding/protection system.

Ensure that cabling is routed properly during installation
• Divide the cabling into different cable groups (High voltage lines, power
supply lines, signal lines, data lines).
• Always install high voltage lines and signal or data lines in separate
channels or bundles.
• Install signal and data lines as close as possible to any metallic ground
surfaces (e.g. frames, metal rails, sheet metal).

Ensure that the screening of lines is grounded properly
• Data lines must be screened. The screen has to be laid both-sided.
• Analog lines must be screened. Where low-amplitude signals are
transferred it may be advisable to connect the screen on one side of the
cable only.
• Attach the screening of cables to the ground rail by means of largesurface connectors located as close as possible to the point of entry.
Clamp cables mechanically by means of cable clamps. Route the
connected screen to the modules without interruptions, but don't
connect the screen again.
• Ensure that the ground rail has a low-impedance connection to the
cabinet/cubicle.
• Use only metallic or metalized covers for the plugs of screened data
lines.
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In critical cases you should implement special EMC measures
• Connect suppressors to all inductive loads that are not controlled by
special EMC-modules.
• Use incandescent lamps for illumination purposes inside cabinets or
cubicles, do not use of fluorescent lamps.

Create a single reference potential and ensure that all electrical
equipment is grounded wherever possible
• Ensure that grounding measures are implemented effectively. The
controllers are grounded to provide protection and for functional
reasons.
• Provide a star-shaped connection between the plant, cabinets/cubicles
and the grounding/ protection system. In this way you can avoid ground
loops.
• Where potential differences exist you must install sufficiently large
equipotential bonding conductors between the different parts of the
plant.
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EMC-equitable assembly
Mostly, measures for suppressing interference voltages are only taken,
when the control is already in commission and the perfect receive of a
wanted signal is disturbed.
Causes for such interference's are in the most cases inadequate reference
potentials, coming from mistakes at the device assembly and installation.

Guidelines for
assembling and
grounding of
inactive metal
parts

When assembling the devices, you have to ensure the large-surface
grounding of the inactive metal parts. A correctly done grounding supports
an unambiguous reference potential for the control and reduces the impact
of coupled interference's.
Grounding means the conducting connection of all inactive metal parts.
The sum of all interconnected inactive parts is called Ground.
Inactive parts are all conductive parts electrically separated from all active
parts by means of a basic isolation and that may only get voltage in case of
an error.
The ground must not adopt dangerous contact voltage even in case of an
error. Thus you have to connect the ground with the protected earth
conductor. To avoid ground loops, local distant ground constructions
(cubicles, construction and machine parts) have to be connected with the
protected earth conductor system in star-topology.
Please regard at grounding:
• Connect the inactive metal parts as carefully as the active ones.
• Take care of impedance-low metal-metal-connections, for e.g. with
large-surface and well conductive contacts.
• If you include coated or anodized metal parts in the grounding, you have
to come through the isolating protection layers. For this you may use
special contact washers or remove the isolation layer.
• Protect the connection points from corrosion, e.g. with grease.
• Moveable grounding parts (e.g. cubicle doors) have to be connected via
flexible ground strips. The ground strips should be short and have a
large surface, because the surface is decisive for the diversion of high
frequency interference's.
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EMC-equitable cabling
Line routing

Content of this section is the line routing of bus, signal and supply lines.
Object of the line routing is to suppress the "slurring" at parallel lines.

Line routing inside
and outside of
cubicles

For an EMC-equitable routing of the lines it is convenient to divide the
cables in different groups and install each group itself:

Group A
• screened bus and data lines
• screened analog lines
• unshielded lines for direct voltage ≤ 60V
• unshielded lines for alternating voltage ≤ 25V
• Coaxial cables for monitors
Group B
• unshielded lines for direct voltage >60V and ≤400V
• unshielded lines for alternating voltage >25V and ≤400V
Group C
• unshielded lines for direct and alternating voltage >400V
Group D
• Lines for H1 respectively TCP/IP

HB116E - OP03 - Rev. 07/50
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Following the table you may see the conditions for the cabling of the line
groups by combining the single groups:
Group A
Group B
Group C
Group D
Group A
[1]
[2]
[3]
[4]
Group B

[2]

[1]

[3]

[4]

Group C

[3]

[3]

[1]

[4]

Group D

[4]

[4]

[4]

[1]

[1]

The lines may be installed in common bundles or cable trusses.

[2]

The lines have to be installed in different bundles or cable trusses
(without min. distance).

[3]

The lines have to be installed in different bundles or cable trusses
inside of cubicles and outside of the cubicle but inside the
building in separated cable trusses with a min. distance of 10cm.

[4]

The lines have to be installed in different bundles or cable trusses
with a min. distance of 50cm.

Line routing
outside of
buildings

Wherever possible, exterior cabling should be installed on metallic cable
trays. A galvanic connection must be provided for joints between cable
trays.
You must abide by the applicable lightning protection and grounding
regulations when installing exterior cables.

Lightning
protection

Attention!
Where cables and signal lines for PLC equipment are installed outside of
buildings, the conditions for internal and external lightning protection must
be satisfied.
• Exterior lines should either be installed in metallic conduit pipes that is
grounded on both ends or in steel-reinforced concrete cable trunks with
continuously connected reinforcing.
• Signal lines should be protected against overvoltage by varistors or by
lightning arrester filled with rare gas.
• Install these protective elements at the location where the cables enter
the building.
Note!
Any lightning protection system must be based on an individual
assessment of the entire plant. For questions please contact VIPA GmbH.
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Equipotential
bonding

Potential differences may occur between different sections when
controllers and peripheral equipment are connected by means of nonisolated connections or the screens of screened cables are connected at
both ends and grounded on different sections of the plant.
One reason for a potential difference may be that different sections of the
plant are powered from different power sources. These potential
differences must be reduced by means of equipotential bonding conductors
to ensure that the electronic equipment employed on the plant operates
properly.

Rules for
equipotential
bonding

• The lower the impedance of the equipotential bonding conductor, the
higher the effectiveness of potential equalization.
• The impedance of the equipotential bonding conductor must not exceed
10% of the impedance of the screen where screened signal lines are
connected between the different sections of the plant and the screening
is connected to ground/neutral on both sides.
• The cross-sectional area of the equipotential bonding conductor must be
calculated to carry the maximum equalization current. The following
cross-sections have been successfully employed:
2
- 16mm Cu for equipotential bonding conductors up to 200m
- 25mm2 Cu for equipotential bonding conductors exceeding 200m
• Use copper or galvanized steel for equipotential bonding conductors.
These must be connected to ground/neutral by means of large-surface
connections that are protected from corrosion.
• The equipotential bonding conductor should be installed in such a
manner that it includes the smallest surface between the bonding
conductor and the signal lines.

Screening of lines
and cables

Screening is one method commonly used to reduce (attenuate) the
interference pick-up from magnetic, electrical or electromagnetic fields.
• Interference on screens is conducted to ground by the conductive
connection between the screen and the screening rain/enclosure. To
avoid interference from these currents it is very important that the
neutral connection is a low-impedance connection.
• You should only use of cables that are provided with a braided screen.
The degree of screening should be more than 80%.
• Avoid cables with foil-type screens as the foil is easily damaged by
tension and pressure at the point of attachment; this can result in
reduced effectiveness of the screening action.
• As a rule you should always ground the screens of cables on both ends.
This is the only way in which you can ensure that high frequency
interference is attenuated properly.

HB116E - OP03 - Rev. 07/50

4-9

Chapter 4 General installation guidelines

One-sided
grounding of
screens
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In exceptional cases it may be necessary to ground the screen on one side
only. However, this will only attenuate the lowest frequencies. The onesided grounding of screens may provide advantages when:
• It is not possible to install an equipotential bonding conductor
• Analogue signals (a few mV or µA) must be transmitted
• Foil-type screening (static screening) is employed.
You should always use metallic or metalized covers for serial data lines.
Connect the screen of the data line to the cover. Do not connect the
screen to PIN 1 of the connector!
In case of stationary operations it is recommended that the remove the
insulation from the screened cable without cutting the screen and to attach
this point to the screening/neutral rail.

Note!
Potential differences may give rise to an equalization current via the screen
connected between the two ground connections.
In this case you must install an additional equipotential bonding conductor.

Connecting the
screen

4-10

Please observe the following points when you handle the screens:
• Use only metallic cable clamps when connecting the screening of
cables. These clamps must provide a good electrical contact and a
large-surface connection to the screen.
• Attach the screens to the screening rail directly at the point where the
cables enter the enclosure. The screening conductor must be continued
to the module without interruption, however, it must not be connected to
the module!

HB116E - OP03 - Rev. 07/50

Manual VIPA HMI

Chapter 4 General installation guidelines

Special precautions providing high noise immunity
Inductors require
suppressors

Inductors controlled by your programmable controller (e.g. contactors and
relays) do not normally require suppressors as the respective modules
have been provided with the required components.
Suppressors must only be connected to inductors when output circuits can
be disabled by means of additional contacts (e.g. relay contacts). In this
case the integrated suppressors on the module are also disabled.
You can connect diodes to suppress back-emc, varistors or RC-networks
to the inductors.
Connections of
DC-activated inductors
using a diode
using a Z-diode
+

+

-

-

Connections of
AC-activated inductors
using a varistor using RC-network

Power outlet for
PGs

Every cubicle must be provided with a power outlet for the PGs. These
outlets must be wired to the distribution system, which is also used to
connect the neutral conductor for the cubicle.

Cubicle
illumination

The cubicle illumination should consist of incandescent lights, e.g.
LINESTRA-lamps. Avoid using fluorescent lamps as these lamps can
cause interference.
If you can not avoid using fluorescent lamps you should implement the
steps outlined in the following figure.

Suppression of
fluorescent lamps
in cubicles

1

2

4

5
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[1]

Fluorescent lamp

[2]

Screen above the lamp

[3]

Screened cable

[4]

Switch with metallic cover

[5]

Powerline filter or screened
power cable

3
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Checklist for the EMC-compliant installation of controllers
EMV-measures

Space for Notes

Connection of the inactive parts
You should take special care to check the connections of:
• Module racks
• Frames
• Screen and protected earth conductor
Are all the inactive metal parts interconnected by means of
large-surface and low-impedance connections?
Has a proper connection been installed with respect to the
ground/protected earth conductor system?
Has the isolation been removed from varnished and anodized
surfaces or have these connections been fitted with special
contact washer?
Have the connection been protected from corrosion, e.g. by
means of grease?
Have doors been grounded by means of grounding straps
connected to the body of the cubicle?
Cable routing
Cabling divided into groups?
Power cables (230...400V) and signal lines installed in
separate channels or bunches?
Potential compensating
When installing the equipment at separate locations, check
the installation of the potential compensating line.
Cable screen
All covers of plugs are metallic?
All analog and data lines installed screened?
Line screens attached to the screening or the protected earth
conductor?
Have the screens been connected by means of large-surface
and low-impedance cable clamps?
Cable screens grounded both-sided where possible?
Inductors
Have the coils of contactors controlled by means of contacts
been connected to suppressors?
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